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INTRODUCTION 
 
Below you will find the year end closing procedures for the following Great Plains modules: 
 

• Inventory 
• Receivables Management 
• Payables Management 
• Fixed Asset Management 
• General Ledger 
• Payroll (independent of all modules) 

 
The below procedures and checklists apply to: 
 

• Microsoft Dynamics GP 10.0 
• Microsoft Dynamics GP 9.0 

 
The below procedures and checklists do not fully apply to the following versions of Great Plains, as 
stated in release by Microsoft Dynamics Support.  Please read documentation entirely before 
proceeding: 
  

• Microsoft Business Solutions–Great Plains 8.0 
• Microsoft Business Solutions–Great Plains 7.5 
• Microsoft Great Plains Dynamics 7.0 
• Microsoft Great Plains eEnterprise 7.0 

 
 
Before any action, please perform a complete backup of all company and system 
databases. 
You can use this checklist for the end of the fiscal year and for the end of the calendar year. 
 
Read the entire module section before you perform any steps. If you have any questions, please 
contact LBMC Technologies at (615) 377-4650 (Nashville) or (865) 691-9000 (Knoxville). 
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Inventory 
Year End Closing Procedures 
 
Inventory year-end closing procedures 
 
Follow these steps to close the year and to prepare your inventory records for the new fiscal 
year. Closing a year transfers all summarized current-year quantity (cost and sales amounts) 
to transaction history for the items for which you have been keeping a summarized Sales 
History. The Quantity Sold field for each item is set to zero. These steps also update the 
amount in each item’s Beginning Quantity field to the Quantity on Hand field at each site. 
 
Checklist of Summary Steps: 
 

1. Post all transactions for the year. 
2. Reconcile inventory quantities. 
3. Complete a physical inventory count, and then post any adjustments. 
4. Print additional reports. 
5. Make a backup. 
6. Close the year. 
7. Close the fiscal periods for the Inventory series (optional). 
8. Make a final backup. 

 
Step 1: Post all transactions for the year 
 
Ensure that all Invoicing, Sales Order Processing and Inventory transactions for the current year 
have been entered and posted before you close the year. This is important to ensure that historical 
information is accurate for the year you're closing and year-to-date amounts are accurately stated 
for the new year. If you wish to enter future-period transactions before closing the year, create a 
new batch with new transactions, but don't post it until after the year has been closed. 
 
Step 2: Reconcile Inventory Quantities 
 
Reconcile quantities for all Inventory Items using the Reconcile Inventory Quantities window to 
ensure that your Inventory Control data hasn't become damaged over the course of the year. To 
open the Reconcile Inventory Quantities window, follow one of these steps: 
 

• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dyanamics GP menu, point 
to Utilities, point to Inventory, and then click Reconcile. 

• In Microsoft Dynamics GP 9.0 and in earlier versions, point to Inventory on the Utilities 
menu, and then click Reconcile. 

 
If any discrepancies are found during the Reconcile process, the quantities will be adjusted. If 
adjustments are made, they'll be reflected on the Reconcile Report, along with any serial numbers 
and lot numbers that were added for the adjusted items. If you want to edit these serial and lot 
numbers, you can use the Item Transaction Entry window (Transactions | Inventory | Transaction 
Entry) to do so by making adjustment transactions. 
 

Step 3: Complete a Physical Inventory count and post any adjustments  

 

• Use the Stock Calendar Maintenance window to set up and maintain information about 
when stock counts can be performed and which days will be counted when the system 
calculates suggested dates for the next stock count for a specific item-site combination. To 
open the Stock Calendar Maintenance window, follow one of these steps: 
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• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP 
menu, point to Setup, then Inventory, and then click Stock Calendar. 

• In Microsoft Dynamics GP 9.0 and in earlier versions, point to Setup on the Tools 
menu, point to Inventory, and then click Stock Calendar. 

• The Stock Count Cycle Assignment window (Cards | Inventory | Count Cycle Assign) can 
be used if it’s desired to assign one stock count frequency to many items.  

• Create a Stock Count Schedule (Transactions | Inventory | Stock Count Schedule) a list of 
the specific items at a specific site that will be counted during a specific count. When a 
stock count schedule is started, the quantity on hand for each line in the stock count 
schedule is captured. Later, the actual count number quantities will be compared to the 
captured values to create default variance transactions. Stock Count Forms can be printed 
during this process.  

• Use the Stock Count Entry window (Transactions | Inventory | Stock Count Entry) to enter 
information about the results of your stock counts. When a stock count is processed, 
variance transactions are created. If the Autopost Stock Count Variances option is marked, 
the transactions also will be posted. 

 

Instead of going through the Stock Count Schedule procedure listed above, you can manually create 
your adjusting entries. Print a Physical Inventory Checklist by using the Inventory Activity Reports 
window (Reports | Inventory | Activity) and perform a physical count of your Inventory Items to 
verify that quantity on hand amounts are accurate for all items. If discrepancies exist, enter the 
necessary adjustments in the Item Transaction Entry window (Transactions | Inventory | 
Transaction Entry) and post to the General Ledger. 
 
Step 4: Print additional reports 
 
Print any additional reports you'll need for planning or your permanent records, including the 
Historical Stock Status Report, Purchase Receipts Report, Turnover Report, Transaction History 
Report, Serial Number List, and Lot Number List. Use selections from the Inventory Reports palette 
(Reports | Inventory) to print these reports. If you plan to remove sold purchase receipts during the 
year-end closing process, we recommend that you print the Purchase Receipts Report to review the 
receipts that will be removed. 
 
Step 5: Make a backup 
 
Make a backup of all Company data. This is important to ensure that you'll be able to recover 
quickly should a power fluctuation or other problem occur during the year-end closing procedure. 
 
Step 6: Close the Year 
 
Closing a year accomplishes the following tasks:  
 

• Transfers all summarized current-year quantity (cost and sales amounts) to transaction 
history for the items in which you've been keeping summarized sales history. 

• Updates the Item's Beginning Quantity field to the Quantity on Hand field for each site. 
Certain reports, such as the Turnover Report, use the Beginning Quantity field for report 
calculations. 

• Zeros the Quantity Sold field in the Item Quantities Maintenance window (Cards | Inventory 
| Item | Qtys/Sites) for each Site. 

• Removes purchase receipts and cost change history for items that have been completely 
sold. 

• Removes any discontinued items from the Item records that have been completely sold. 
• Removes any lot attributes from the records of lot numbered items if they have been 

completely sold. 
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• Updates the standard cost of each item to the current cost if you use either the FIFO 
periodic method or the LIFO periodic valuation method.  

• Uses the Inventory Year-End Closing window (GP | Tools | Routines | Inventory | Year-End 
Close) to close the year.  

 
Use the following descriptions to learn more about each option that is available: 
 
• Remove Discontinued Items - If you mark the Discontinued Items checkbox option, all 

discontinued items that have a zero balance will be removed during the year-end closing 
process (items can be designated as discontinued using the Item Maintenance window). 
Discontinued items that have a quantity on hand of zero (except for kit components) and 
do not have any unposted transactions will be completely removed from the Inventory 
module.  If using the Service module, verify whether any discontinued items exist on any 
unposted service documents. If so, the documents must be posted before proceeding. The 
Sales Order Processing, Invoicing, or Purchase Order Processing reports and inquiries will 
still be able to pull information regarding these discontinued items; however, you will not 
be able to do a lookup on the Item Number since it has been removed from the Item 
Master table. If you would like to print a report or inquire on the discontinued Item, you will 
need to include the item within the Item Number Range. 
 
Note: If you select this option, you will remove the discontinued items. Additionally, you 
will remove all inventory history for the items. You will not be able to drill back on the 
inventory history for these items. 

 
• Remove Sold Receipts -  

 
• In Microsoft Dynamics GP 10.0 or in Microsoft Dynamics GP 9.0: Remove 

Sold Receipts and Cost Change History Prior To- You click to select the Sold 
Receipts and Cost Change History Prior To checkbox to remove all sold purchase 
receipts and historical cost changes for items that use Average Perpetual, Last In, 
First Out (LIFO) Perpetual, or the First In, First Out (FIFO) Periodic valuation 
method, and then enter a date. The sold receipts, quantity sold details, and 
historical cost changes with dates that come before the date that you entered will 
be removed. 

 
• In Microsoft Business Solutions- Great Plains 7.0-8.0: Remove Sold Receipts- 

If you click to select the Sold Receipts checkbox, all sold receipts whose quantity 
received amount and quantity sold amount are equal will be removed. This is an 
optional step, and it may not be a procedure that is performed every year-end. 
These values may help when items are returned through Invoicing. Therefore, you 
may not want to remove the purchase receipts from the file. 

 
• Remove Sold Lot Attributes - If you mark the Sold Lot Attributes checkbox, values for 

completely sold lot numbers will be removed. For example, you can remove the value red 
for the lot attribute color if you've sold all lot numbered items that have been assigned the 
value red. 

 
• Update an Item's Standard Cost - If you mark the Item's Standard Cost checkbox, the 

Standard Cost for any items that have been assigned the FIFO or LIFO periodic valuation 
method will be adjusted automatically to reflect each item’s current cost or the amount you 
most recently paid for the item.  

 
When you have selected all the options you want, click Process to begin the year-end 
closing process. While the year is being closed, you will be unable to post, reconcile 
quantities, change valuation methods, or change decimal places for items.  
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Step 7: Close the fiscal periods for the Inventory series (optional)  
 
You can use the Fiscal Periods Setup window to close any fiscal periods that are still open for 
the year. To open the Fiscal Periods Setup window, follow one of these steps: 
 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, point to 

Setup, point to Company, and then click Fiscal Periods. 
• In Microsoft Dynamics GP 9.0 and earlier versions, point to Setup on the Tools menu, point 

to Company, and then click Fiscal Periods. 
 
This keeps transactions from accidentally being posted to the wrong period or year. En sure you 
have posted all transactions for the period and year for all modules before closing fiscal periods. 
If you later need to post transactions to a fiscal period that has already been closed, you need 
to return to the Fiscal Periods Setup window to reopen the period before you can post the 
transaction. 
 
Step 8: Make a final backup 
 
Make a final backup of your Company's data files and keep it in safe, permanent storage. This 
gives you a permanent record of the Company's financial position at the time you closed the 
year, and can be restored later if necessary. 
 
Inventory Year-End Closing Tips 
 

• The year-end close must be done before any transactions for the new year have been 
posted. 

 
• You have the option of marking the Discontinued Items, Sold Receipts, or Sold Lot 

Attributes checkboxes. If marked, all items, sold receipts and sold attributes that have 
a zero balance will be removed during the year-end closing process. 

 
• If you mark the Update Item's Standard Cost checkbox, the standard cost for any items 

that have been assigned the FIFO or LIFO periodic valuation methods will be adjusted 
automatically to reflect each item’s current cost (the amount you most recently paid for 
the item). 

 
• There is no Year End Closing report for Inventory. 
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Receivables Management 
Year End Closing Procedures 
 
Note: You can use this checklist for the end of the fiscal year and for the end of the calendar year. 
 
Although Receivables Management is date sensitive in Microsoft Great Plains 7.0 and later versions 
of Microsoft Great Plains, the following are updated based on the closing of Receivables 
Management: 
 

• The SmartList objects 
• The Receivables Management summary reports 
• The Amounts Since Last Close view in the Customer Summary Window 

 
Therefore, we recommend that you follow these steps so that the SmartList objects, the Receivables 
Management summary reports, and the Amounts Since Last Close view contain the correct 
information: 
 

1. Post all sales and receivables transactions for the year. 
2. Make a pre-year-end closing backup. 
3. Close the year. 
4. Close the fiscal periods. (This step is optional) 
5. Close the tax year. 
6. Make a post-year-end closing backup. 

 
 
Step 1: Post all sales and receivables transactions for the year 
 
Post all the sales and receivables transactions for the year before you close the year. If you want to 
enter sales and receivables transactions for a future period before you close the year, create a batch 
that contains the transactions and save it. Post the batch after you close the year. 
 
You must close the year because some areas of Microsoft Dynamics GP are not date sensitive. If 
you do not close the year after you enter all the transactions for 2009 and before you enter all the 
2010 transactions, these areas will contain incorrect information. However, you can change 
information in the Amounts Since Last Close view in the Customer Summary window and in the 
Customer Finance Charge Summary window if you have to change that information. The following 
are the areas of Microsoft Dynamics GP that are not date sensitive:  

 
• The Amounts Since Last Close view in the Customer Summary window 
 
To open the Amounts Since Last Close view in the Customer Summary window, follow these 
steps: 

1. On the Cards menu, point to Sales, and then click Summary. 
2. In the Customer Summary window, type a customer ID in the Customer ID box. 
3. In the Summary View list, click Amounts Since Last Close. 

 
• The Customer Finance Charge Summary window 

 
To open the Customer Finance Charge Summary window, follow these steps: 

1. On the Cards menu, point to Sales, and then click Summary. 
2. In the Customer Summary window, type a customer ID in the Customer ID field. 
3. Click Finance Charges. 

 
• The SmartList objects 
 
To view the SmartList columns that are affected, follow these steps: 
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1. Use the appropriate method: 
• In Microsoft Dynamics GP 10.0, click Columns on the Microsoft Dynamics GP 

menu, click SmartList, expand Sales, expand Customers, and then click Add. 
• In Microsoft Dynamics GP 9.0 and earlier versions, click SmartList on the View 

menu, expand Customers, click Columns, and then click Add. 
2. Select the following items in the Available Columns list.  

 
Note: The items that are flagged with an asterisk (*) are affected by the calendar 
year-end close. All the other items are affected by the fiscal year-end close. 
 
• Average Days to Pay- Year 
• Finance Charges CYTD* 
• Finance Charges LYR Calendar* 
• High Balance LYR 
• High Balance YTD 
• Number of ADTP Documents – LYR 
• Number of ADTP Documents – Year 
• Number of NSF Checks YTD 
• Total # FC LYR* 
• Total # FC YTD* 
• Total # Invoices LYR 
• Total # Invoices YTD 
• Total Amount of NSF Check YTD 
• Total Bad Debt LYR 
• Total Bad Debt YTD 
• Total Cash Received LYR 
• Total Cash Received YTD 
• Total Discounts Available YTD 
• Total Discounts Taken LYR 
• Total Discounts Taken YTD 
• Total Finance Charges LYR* 
• Total Finance Charges YTD* 
• Total Returns LYR 
• Total Returns YTD 
• Total Sales LYR 
• Total Sales YTD 
• Total Waived FC LYR* 
• Total Waived FC YTD* 
• Total Writeoffs LYR 
• Total Writeoffs YTD 
• Unpaid Finance Charges YTD* 
• Write Offs LYR 
• Write Offs YTD 

 
3. Click Ok twice 

 
Step 2: Make a pre-year-end closing backup 
 
Create a backup before you close the year. Put the backup in safe permanent storage. This backup 
makes sure that you have a permanent record of the company's financial position at the end of the 
year. You can restore from this backup if you have to. For example, this backup would let you 
quickly recover if a power fluctuation or another problem occurs during the year-end close 
procedure. 
 

1. To create a back up in Microsoft Dynamics GP or in Microsoft Great Plains, follow these 
steps: Use the appropriate method: 
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• In Microsoft Dynamics GP 10.0, point to Maintenance on the Microsoft Dynamics GP 
menu, and then click Backup. 

• In Microsoft Dynamics GP 9.0 or earlier versions, click Backup on the File menu. 
2. In the Back Up Company window, select your company name in the Company Name list. 
3. Change the path of the backup file if it is required, and then click OK. 

 
Note: We recommend that you name this backup "PreYearEndClosingBackup2009" 
 
Step 3: Close the year 
 

1. Use the appropriate method: 
• In Microsoft Great Plains 7.0 and 7.5, click Routines, click Sales, and then click Year-

End Close. 
• In Microsoft Great Plains 8.0 and in Microsoft Dynamics GP 9.0, point to Routines on 

the Tools menu, point to Sales, and then click Year-End Close. 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point to Sales, and then click Year-End Close. 
2. If you are closing both the fiscal year and the calendar year at the same time, click All. If 

you are closing only the calendar year, click Calendar. If you are closing only the fiscal 
year, click Fiscal. 

3. Click to select the Print Report check box, and then click Close Year. 
 
Note: We recommend that you keep a paper copy (or PDF) of the year-end report together with 
your permanent year-end audit records. 
 
Calendar year details 
 
The calendar year-end process in Microsoft Dynamics GP clears the following fields in the Customer 
Summary window: 
 

• Finance Charges CYTD 
• Total # FC YTD 
• Total Finance Charges YTD 
• Total Waived FC YTD 
• Unpaid Finance Charges YTD 

 
The calendar year-end process updates the amounts in the following fields: 
 

• *Finance Charges LYR Calendar 
• * Total # FC LYR 

 
Fiscal year details 
 
The fiscal year-end process in Microsoft Dynamics GP clears the following fields in the Customer 
Summary window: 
 

• Average Days to Pay- Year 
• High Balance YTD 
• Number of ADTP Documents- Year 
• Number of NSF Checks YTD 
• Total # Invoices YTD 
• Total Amount of NSF Check YTD 
• Total Bad Debt YTD 
• Total Cash Received YTD 
• Total Discounts Available YTD 
• Total Discounts Taken YTD 
• Total Returns YTD 
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• Total Sales YTD 
• Total Writeoffs YTD 
• Write Offs YTD 

 
The fiscal year-end process updates the amounts in the following fields: 
 

• High Balance LYR 
• Number of ADTP Documents- LYR 
• Total # Invoices LYR 
• Total Bad Debt LYR 
• Total Cash Received LYR 
• Total Discounts Taken LYR 
• Total Returns LYR 
• Total Sales LYR 
• Total Writeoffs LYR 
• Write Offs LYR 

 
Step 4: Close the fiscal periods (This step is optional) 
 
To prevent users from accidentally posting transactions to the wrong period or to the wrong year, 
use the Fiscal Periods setup window to close all fiscal periods that are still open for the year. Before 
you close fiscal periods, verify that you have posted all transactions for the period and for the year 
for all modules. If you must later post transactions to a fiscal period that you already closed, you 
can return to the Fiscal Periods Setup window to reopen the period so that you can post the 
transactions. 
 
To close a fiscal period, follow these steps: 
 

1. Use the appropriate method: 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Company, and then click Fiscal Periods. 
• In Microsoft Dynamics GP 9.0 or earlier versions, point to Routines on the Tools Menu, 

point to Company, and then click Fiscal Periods. Click to select the Sales check box for 
the period that you want to close. 

 
Step 5: Close the tax year 
 
Note: Follow these steps only after you complete the year-end closing procedures for all the sales 
and purchasing modules. 
 
To close the tax year, follow these steps: 
 

1. Use the appropriate method: 
• In Microsoft Great Plains 7.5 and 7.0, click Routines, click Company, and then click 

Year-End Close. 
• In Microsoft Dynamics GP 9.0 and in Microsoft Great Plains 8.0, point to Routines on 

the Tools menu, point to Company, and then click Tax Year-End Close. 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point to Company, and then click Tax Year-End Close. 
2. Click to select the Close Year check box and the Print Report check box. 
3. Click Process. 

 
Note: We recommend that you keep a paper copy (or PDF) of the year-end report together with 
your permanent year-end audit records. 
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Step 6: Make a post-year-end backup 
 
Create a backup after you close the year. Put the backup in safe permanent storage. This backup 
makes sure that you have a permanent record of the company's financial position at the end of the 
year. You can restore from this backup if you have to. For example, this backup would let you 
quickly recover if a power fluctuation or another problem occurs during the year-end close 
procedure. 
 
To create a backup in Microsoft Dynamics GP or in Microsoft Great Plains, follow these steps: 
 

1. Use the appropriate method 
•  In Microsoft Dynamics GP 10.0, point to Maintenance on the Microsoft Dynamics 

GP menu, and then click Backup. 
• In Microsoft Dynamics GP 9.0 and earlier versions, click Backup on the File menu. 

2. In the Back Up Company window, click your company name in the Company Name list. 
3. Change the path of the backup file if it is required, and then click OK. 

 
Note: We recommend that you name this backup "PostYearEndClosingBackup2009." 
 
 
Year-to-date finance charges on customer statements for December and for January 
Year-to-date finance charges are not automatically printed on customer statements for December 
and for January. 
 
December statements 
To add the year-to-date finance charges to the December statements, follow these steps: 
 

1. Use the appropriate method: 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Customize, and then click Report Writer. 
• In Microsoft Dynamics GP 9.0 or earlier versions, point to Customize on the Tools 

menu, and then click Report Writer. 
2. In the Product list, click Microsoft Dynamics GP, and then click ok. 
3. Click Reports. 
4. Use the appropriate method: 

• If you have not previously modified the statement form, click the statement form 
that you print in the Original Reports list, click Insert, and then click the statement 
form in the Modified Reports list. 

• If you previously modified the statement form, click the statement form in the 
Modified Reports list. 

5. Click Open. 
6. In the Report Definition window, click Tables. 
7. In the Report Tables window, click RM Customer MSTR, and then click New. 
8. In the Related Tables window, click Customer Master Summary, and then click OK. 
9. Click Close. 
10. Click Layout. 
11. In the resource list in the Toolbox box, click Customer Master Summary. 
12. In the field list, drag Finance Charges CYTD to the layout of the report. You can position 

this field in any section of the report. 
13. On the File menu, click Microsoft Dynamics GP. When you are prompted to save changes, 

click Save. 
14. If you have not previously modified this report, you must grant security to the report. To do 

this, use the appropriate method. 
 

Microsoft Dynamics GP 10.0 
a. On the Microsoft Dynamics GP menu, point to Tools, point to Setup, point to Systems, 

and then click Alternate/Modified Forms and Reports. 
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b. In the ID box, enter the user ID. 
c. In the Product list, click Microsoft Dynamics GP. 
d. In the Type list, click Reports. 
e. Expand Sales, and then expand the node of the modified form. 
f. Click Microsoft Dynamics GP (modified). 

  
Microsoft Dynamics GP 9.0 or earlier versions 
Use one of the following methods: 

• Use the Advanced Security tool. To do this, follow these steps: 
a. On the Tools menu, point to Setup, point to System, and then click Advanced 

Security. If you are prompted, type the system password. 
b. Click View, and then click by Alternate, Modified, and Custom. 
c. Expand Microsoft Dynamics GP, expand Reports, expand Sales, and then 

expand the statement form. 
d. Click Microsoft Dynamics GP (Modified) 
e. Click Apply, and then Ok. 

   
Note: By default, the current user and the current company are selected when you start the 
Advanced Security tool. Any changes that you make are for the current user and the current 
company. However, you can select additional users in the User area of the  Advanced Security 
window. You can select additional companies in the Company area of the  Advanced Security 
window. 
 

• Use standard Microsoft Dynamics GP security. To do this, follow these steps: 
a. On the Tools menu, point to Setup, point to System, and then click Security. If 

you are prompted, type the system password. 
b. In the User ID list, click the user ID of the user who you want to access the 

report. 
c. In the Type list, click Modified Reports. 
d. In the Series list, click Sales. 
e. In the Access List box, double-click the statement form, and then click OK. An 

asterisk appears next to the report name. 
 
January statements 
To add the year-to-date finance charges to the January statements, follow these steps: 
 

1. Follow steps 1 through 11 in the “December statements” section. 
2. In the field list, drag Finance Charges LYR Calendar to the layout of the report. You can 

position this field in any section of the report. 
3. Follow steps 13 and 14 in the “December statements” section. 
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Payables Management 
Year End Closing Procedures 
 
Payables Management master year-end closing checklist 
 
Note: Use this checklist if you are closing your fiscal year and your calendar year at the same time. 
 

1. Post all transactions for the year. 
2. Print the Aged Trial Balance with Options report. 
3. Print the Vendor Period Analysis Report. 
4. Install the year-end update. 
5. Make a backup that is named "Pre-1099 Edits." 
6. Verify the 1099 information and edit it if it is required. 
7. Print the 1099 statements. 
8. Make a backup that is named "Pre Year-End." 
9. Close the year. 

10. Close the fiscal periods. 
11. Close the tax year. 
12. Make a backup that is named "Post Year-End." 

 
Payables Management calendar year-end closing checklist 
 
Note: Although the Payables Management module is date-sensitive in Microsoft Great Plains version 
7.0 and in later versions, the SmartList objects, the Payables Management summary reports, and 
the Amounts Since Last Close view of the Vendor Yearly Summary window are updated based on 
the closing of the Payables Management module. Therefore, we recommend that you follow these 
steps so that the SmartList objects, the Payables Management summary reports, and the Amounts 
Since Last Close view of the Vendor Yearly Summary window are correct. 
 

1. Post all transactions for the calendar year. 
2. Print the Aged Trial Balance with Options report. 
3. Make a backup that is named "Pre-1099 Edits." 
4. Verify the 1099 information and edit it if it is required. 
5. Print the 1099 statements. 
6. Install the year-end update. 
7. Make a backup that is named "Pre Year-End." 
8. Close the calendar year. 
9. Close the fiscal periods. 

10. Close the tax year. 
11. Make a backup that is named "Post Year-End." 

 
Payables Management fiscal year-end closing checklist 
 

1. Post all transactions for the fiscal year. 
2. Print the Vendor Period Analysis Report. 
3. Make a backup that is named "Pre Year-End." 
4. Close the fiscal year. 
5. Close the fiscal periods. 
6. Make a backup that is named "Post Year-End." 

 
Note: Detailed information for each step in the year-end checklist  
 
Step 1: Post all transactions for the year 
 
Post all transactions for the year before you close the year. If you want to enter future period 
transactions before you close the year, create a new batch for the future period transactions. Save 
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the future period transactions in the new batch, but do not post the new batch until after the year 
has been closed. 
 
The following areas of Microsoft Dynamics GP are not date-sensitive:  
 

• The Amounts Since Last Close view of the Vendor Yearly Summary window 
• SmartList objects 
• Vendor Summary reports 

 
These areas of Microsoft Dynamics GP will be incorrect if you do not close the payables year after 
you enter all 20092010 transactions and before you enter all 2010 transactions. However, the 
Amounts Since Last Close view of the Vendor Yearly Summary window is editable. Therefore, you 
can update the information in the Amounts Since Last Close view of the Vendor Yearly Summary 
window if it is required.  
 
To access the Amounts Since Last Close view of the Vendor Yearly Summary window, follow these 
steps: 
 

1. On the Cards menu, point to Purchasing, and then click Summary. 
2. In the Vendor Credit Summary window, type a vendor ID in the Vendor ID field, and then 

click Yearly. 
3. In the Summary View list, click Amounts Since Last Close. 

 
To view the Vendor Summary reports, follow these steps: 
 

1. On the Reports menu, point to Purchasing, and then click Analysis.  
2. In the Reports list, click Calendar Year. 
3. In the Options list, click an option, and then click Print. 

 
Step 2: Print the Aged Trial Balance with Options report 
 
We recommend that you print a paper copy of the Aged Trial Balance with Options report to keep 
with your year-end permanent financial records. To do this, follow these steps: 
 

• On the Reports menu, point to Purchasing, and then click Trial Balance. 
• In the Reports list, click Aged Trial Balance with Options. 

 
Step 3: Print the Vendor Period Analysis report 
 
We recommend that you print a paper copy of the Vendor Period Analysis report to keep with your 
year-end permanent financial records. To do this, follow these steps 

• On the Reports menu, point to Purchasing, and then click Analysis. 
• In the Reports list, click Period. 

 
Step 4: Install the year-end update 
 
If there are compliance changes for Payables Management, such as 1099 form changes, install the 
Payroll year-end update. If there are no changes or compliance issues for the tax year for Payables 
Management, you may skip this step.  
 
Review the changes that are included in the Payroll year-end update. To do this, visit the 
appropriate Microsoft Web site:  
Customers 
https://mbs.microsoft.com/customersource/downloads/taxupdates 
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Step 5: Make a backup that is named "Pre-1099 Edits" 
 
Create a backup, and then put the backup in safe, permanent storage. A backup gives you a 
permanent record of the company's financial position at the end of the year, and this backup can be 
restored later if it is required. A backup lets you recover data quickly if a power fluctuation or other 
problem occurs during the year-end closing procedure. 
 
To create a backup in Microsoft Dynamics GP, follow these steps: 
 

1. Use the appropriate step: 
• In Microsoft Dynamics GP 10.0, point to Maintenance on the Microsoft Dynamics GP 

menu, and then click Backup. 
• In Microsoft Dynamics GP 9.0 and earlier versions, click Backup on the File menu. 

2. In the Company Name list, click your company name. 
3. Change the path of the backup file if it is required, and then click OK. 

 
Note: We recommend that you name this backup "Pre-1099 Edits" to differentiate it from your 
other backups. 
 
Step 6: Verify the 1099 information and edit it if it is required 
 
To print the 1099 edit list, follow these steps: 
 

1. Use the appropriate step: 
• In Microsoft Great Plains 7.0 and in Microsoft Great Plains 7.5: Click Routines, click 

Purchasing, and then click Print 1099. 
• In Microsoft Great Plains 8.0 and in Microsoft Dynamics GP 9.0: On the Tools 

menu, point to Routines, point to Purchasing, and then click Print 1099. 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point to Purchasing, and then click Print 1099. 
 
To edit the 1099 information for a vendor, follow these steps: 
 
Method 1: 
 

1. On the Cards menu, point to Purchasing, and then click 1099 Details. 
2. In the Vendor ID list, click a vendor ID. 
3. In the Tax Tupe list, select one of the following; 

• Dividend 
• Interest 
• Miscellaneous 

4. In the Display area, click Month or Year, and then type 2009 in the Year field. 
5. In the Amount column, type the correct 1099 amount. 
6. Click Save. 

 
Method 2: 
 

1. On the Cards menu, point to Purchasing, and then click Summary. 
2. In the Vendor ID list, click a vendor ID, and then click Period. 
3. In the Year field, type 2009. 
4. In the Month/Period field, select the appropriate month or period. 
5. Click the “1099 Details” button that appears next to the 1099 Amount field. 
6. In the Amount column, type the correct 1099 amount. 
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Method 3: 
 

1. On the Cards menu, point to Purchasing, and then click Summary. 
2. In the Vendor ID field, type the ID of the vendor whose 1099 amounts you must edit, and 

then click Period. 
3. In the Year field, type 2009. 
4. In the Month/Period field, type the number of the period that you must edit. 
5. In the 1099 Amount field, type the correct 1099 amount. 
6. Click Save. 

 
Step 7: Print the 1099 statements 
 
Note: You can follow step 7 at any time.  
 
To print the 1099 statements, follow these steps: 
 

1. Use the appropriate step: 
• In Microsoft Great Plains 7.0 and in Microsoft Great Plains 7.5: Click Routines, click 

Purchasing, and then click Print 1099 
• In Microsoft Great Plains 8.0 and in Microsoft Dynamics GP 9.0: On the Tools 

menu, point to Routines, point to Purchasing, and then click Print 1099. 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point to Purchasing, and then click Print 1099. 
2. In the 1099 Year field, type 2009. 
3. Each of your 1099 report types must be printed separately. In the Print 1099 window, click 

the options that you want in the 1099 Type field and in the 1099 Box Number field, and 
then click Print. 

 
The following table provides additional information about the fields on the 1099 form and where this 
information can be located in Microsoft Dynamics GP: 

Field Window where data is located 

Payers name, street address, city, state, and ZIP 
Code/Postal Code 

Print 1099 window 

Payers Federal Identification number Print 1099 window 

Recipients name, address, and Zip Code/Postal Code Primary Address of the Vendor 
Maintenance window 

Recipients identification number Tax ID field of the Vendor Maintenance 
Options window 

Amounts for boxes 1-9 on the Dividend Form or 1-16 
on the Miscellaneous Form 

1099 Amount field in the Vendor Yearly 
Summary window 

 
Currently, Microsoft Dynamics GP does not handle magnetic media filing of state 1099s. For more 
information about Microsoft Dynamics GP Partners that offer compatible State W-2 and 1099 
magnetic media products contact Will Collins at wcollins@lbmc.com. 
 
Step 8: Make a backup that is named "Pre Year-End" 
 
Create a backup, and then put the backup in safe, permanent storage. A backup gives you a 
permanent record of the company's financial position at the end of the year, and this backup can be 
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restored later if it is required. A backup lets you recover data quickly if a power fluctuation or other 
problem occurs during the year-end closing procedure. 
 
To create a backup in Microsoft Dynamics GP, follow these steps: 
 

1. Use the appropriate step: 
• In Microsoft Dynamics GP 10.0, point to Maintenance on the Microsoft Dynamics GP 

menu, and then click Backup. 
• In Microsoft Dynamics GP 9.0 and earlier versions, click Backup on the File menu. 

2. In the Company Name list, click your company name. 
3. Change the path of the backup file if it is required, and then click OK. 

 
Note: We recommend that you name this backup "AP Pre Year-End" to differentiate it from your 
other backups. 
 
Step 9: Close the year 
 
To close the year, follow these steps: 
 

1. Use the appropriate method: 
• In Microsoft Great Plains 7.0 and in Microsoft Great Plains 7.5: Click Routines, click 

Purchasing, and then click Year-End Close 
• In Microsoft Great Plains 8.0 and in Microsoft Dynamics GP 9.0: On the Tools 

menu, point to Routines, point to Purchasing, and then click Year-End Close. 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point to Purchasing, and then click Year-End Close. 
2. If you are closing both your fiscal and calendar year at the same time, click All. If you are 

just closing your calendar year, click Calendar.  
3. If you are just closing your fiscal year, click Fiscal. 
4. Click to select the Print Report check box, and then click Close Year. 

 
Note: We recommend that you keep a paper copy of the year-end report together with your 
permanent year-end audit records. 
 
To view the Vendor Yearly Summary window, follow these steps: 
 

1. On the Cards menu, point to Purchasing, and then click Summary. 
2. In the Vendor ID field, type a vendor ID to view, and then click Yearly.  

 
The calendar year details 
 
The calendar year-end process in Microsoft Dynamics GP will clear the 1099 Amount Year to Date 
field and then transfer the amount to the 1099 Amount Last Year field for the Amounts Since Last 
Close view of the Vendor Yearly Summary window. 
 
The fiscal year details\ 
 
The fiscal year-end process in Microsoft Dynamic will clear the following fields: 
 

• Amount Billed YTD 
• Amount Paid YTD 
• Average Dats to Pay- Year 
• Discount Available YTD 
• Discount Lost YTD 
• Discount Taken YTD 
• Finance Charge YTD 
• Number of Finance Charges YTD 
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• Number of Invoices YTD 
• Number of Paid Invoices YTD 
• Returns YTD 
• Trade Discounts Taken YTD 
• Withholding YTD 
• Write Offs YTD 

 
The amounts in these fields will also be updated in the Amounts Since Last Close view of the Vendor 
Yearly Summary window: 
 

• Amount Billed LYR 
• Amount Paid LYR 
• Discount Available LYR 
• Discount Lost LYR 
• Discount Taken LYR 
• Finance Charge LYR 
• Number of Finance Charges LYR 
• Number of Invoice LYR 
• Returns LYR 
• Trade Discounts Taken LYR 
• Withholding LYR 
• Write Offs LYR 

 
Step 10: Close the fiscal periods 
 
You can use the Fiscal Periods Setup window to close any fiscal periods that are still open for the 
year. This prevents users from accidentally posting transactions to the wrong period or year. Verify 
that you have posted all transactions for the period and the year for all modules before closing fiscal 
periods. If you must later post transactions to a fiscal period that you have already closed, you can 
return to the Fiscal Periods Setup window to reopen the period before you can post a transaction.  
 
To close a fiscal period, follow these steps: 
 

1. Use the appropriate step: 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Setup, point to Company, and then click Fiscal Periods. 
• In Microsoft Dynamics GP 9.0 and earlier versions, point to Setup on the Tools 

menu, point to Company, and then click Fiscal Periods. 
2. Click to select the Purchasing checkbox for the Period that you must close. 

 
Step 11: Close the tax year 
 
Note: This procedure should only be completed after you have completed the year-end closing 
procedures for all sales and purchasing modules. 
 
To close the tax year, follow these steps: 
 

1. Use the appropriate step: 
• In Microsoft Great Plains 7.0 and in Microsoft Great Plains 7.5: Click Routines, click 

Company, and then click Year-End Close 
• In Microsoft Great Plains 8.0 and in Microsoft Dynamics GP 9.0: On the Tools 

menu, point to Routines, point to Company, and then click Tax Year-End Close. 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point to Company, and then click Tax Year-End Close. 
2. Click to select the Close Year check box and the Print Report check box. 
3. Click Process. When you are prompted to continue with the year-end close, click Yes. 

 



   

Microsoft Dynamics GP 
Year End Closing Procedures 

 

Page 18 of 38 

Note: We recommend that you keep a paper copy (or PDF) of the year-end report together with 
your permanent year-end audit records. 
 
Step 12: Make a backup that is named "Post Year-End" 
 
Create a backup, and then put the backup in safe, permanent storage. A backup gives you a 
permanent record of the company's financial position at the end of the year, and this backup can be 
restored later if it is required. A backup lets you recover data quickly if a power fluctuation or other 
problem occurs during the year-end closing procedure. 
 
To create a backup in Microsoft Dynamics GP, follow these steps: 
 

• Use the appropriate step; 
• In Microsoft Dynamics GP 10.0, point to Maintenance on the Microsoft Dynamics GP 

menu, and then click Backup. 
• In Microsoft Dynamics GP 9.0 and earlier versions, click Backup on the file menu. 

• In the Company Name list, click your company name. 
• Change the path of the backup file if it is required, and then click OK. 

 
Note: We recommend that you name this backup "AP Post Year-End" to differentiate it from your 
other backups. 
 
Frequently asked questions 
Q1: Are inactive vendor records cleared during year-end closing? If not, how can inactive 
vendor records be removed?  
 
A1: No, inactive vendor records are not automatically removed. To remove an inactive vendor 
record, the following conditions must be true:  

• No current year 1099 amounts exist for the vendor 

• The vendor has no documents in work or history. 

To delete all inactive vendor records that fit these criteria, follow these steps:  

1. Use the appropriate step:  

• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 
point to Utilities, point to Purchasing, and then click Mass Vendor Delete.  

• In Microsoft Dynamics GP 9.0, point to Utilities on the Tools menu, point to 
Purchasing, and then click Mass Vendor Delete. 

 

2. In the Range list, click by Vendor Status. 

3. In the From list, click Inactive. 

4. In the To list, click Inactive. 

5. Click Process. 

Q2: What should I do if I must issue a check on January 2, 2010 but I am not ready to 
close 2009 yet? 
 
A2: Print the checks, but post them after you process your year-end closing. If you must post the 
checks immediately, change the Amount Paid fields in the Amounts Since Last Close view of the 
Vendor Yearly Summary window. 
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Fixed Asset Management 
Year End Closing Procedures 
 
Year-end checklist 
1. Perform all year-end closing procedures for the Payables Management module. 
2. Enter all fixed asset transactions for the current fiscal year. 
3. Depreciate all assets through the last day of the current fiscal year. 
4. Optional: Perform the GL Posting (GL Interface) process. 
5. Run any year-end reports that you want to keep as part of your year-end financial records. 
6. Optional: Guarantee that the Fixed Assets Calendar is built correctly. 
7. Verify that the quarters are set up correctly for all fiscal years.  
8. Create a backup. 
9. Perform the fixed assets year-end closing routine. 
 
MORE INFORMATION 
 
Year-end checklist 
 
Step 1: Perform all year-end closing procedures for the Payables Management module. 
 
Close the Payables Management module first. This action guarantees that all outstanding fixed asset 
transactions are capitalized.  
 
Step 2: Enter all fixed asset transactions for the current fiscal year. 
 
Post all additions, changes, transfers, and retirements for the current fiscal year. 
 
Note: Transfers and undo retirement transactions should never be performed in a historical year.  
 
Step 3: Depreciate all assets through the last day of the current fiscal year. 
 

1. Use the appropriate method: 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point Fixed Assets, and then click Depreciate. 
• In Microsoft Dynamics GP 9.0 or in Microsoft Business Solutions – Great Plains 8.0, 

point to Tools menu, point to Fixed Assets, and then click Depreciate. 
2. In the Depreciation Target Date box, type the last day of the current fiscal year. 
3. Click All to insert all the fixed asset books. 
4. Click Depreciate. 

 
Step 4: Optional: Perform the GL Posting (GL Interface) process. 
 

1. Use the appropriate method: 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point Fixed Assets, and then click GL Posting. 
• In Microsoft Dynamics GP 9.0 or in Microsoft Business Solutions – Great Plains 8.0, 

point to Tools menu, point to Fixed Assets, and then click GL Posting. 
2. In the Beginning Period box, type 2009-012. 

 
Note: The placeholder 2009-012 represents period 12 of the fiscal year 2009. If you are 
not running on a calendar fiscal year or if you have more than 12 periods, the period that 
you type is different. 
 

3. In the Ending Period box, type 2009-012. 
4. In the Transaction Date box, type the last day of the current fiscal year, or type the date 

when you need the posting to affect the general ledger. 
5. Click Continue. 
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6. When you receive a message that the batch number is being created, click Continue.  
7. In the Report Destination window, click to select the Printer check box, and then click OK.  

 
Note: You may want to keep this report as part of your year-end financial records. 

 
Step 5: Run any year-end reports that you want to keep as part of your year-end financial 
records. 
 
The year-to-date depreciation amounts for previous fiscal years are not kept in the Fixed Asset 
Management module. Therefore, you must print any reports that contain this information before you 
close the year.  
 
There are several reports available for fixed assets. We recommend that you print the following 
reports:  

• Annual Activity 
o To print the Annual Activity report, point to Fixed Assets on the Reports menu, and 

then click Activity. 
• Additions 

o To print the Additions report, point to Fixed Assets on the Reports menu, and then 
click Transaction.  

• Retirements 
o To print the Retirements report, point to Fixed Assets on the Reports menu, click 

Transaction, and then click Retirements in the Reports list. 
• Transfers 

o To print the Transfers report, point to Fixed Assets on the Reports menu, click 
Transaction, and then click Transfers in the Reports list. 

• Depreciation Ledger 
o To print the Depreciation Ledger report, point to Fixed Assets on the Reports menu, 

click Depreciation, and then click Depreciation Ledger in the Reports list. 
• Property Ledger 

o To print the Property Ledger report, point to Fixed Assets on the Reports menu, 
click Inventory, and then click Property Ledger in the Reports list. 

• Fixed Assets to General Ledger Reconciliation 
o To print the Fixed Assets to General Ledger Reconciliation report, point to Fixed 

Assets on the Reports menu, click Activity, and then click Fixed Assets to General 
Ledger Reconciliation in the Reports list. 

 
If you have more than one fixed asset book, we recommend that you also print the following 
reports: 

• Book to Book Reconciliation 
o To print the Book to Book Reconciliation report, point to Fixed Assets on the 

Reports menu, and then click Comparison.  
• Book to Book YTD Depreciation Comparison 

o To print the Book to Book YTD Comparison report, point to Fixed Assets on the 
Reports menu, click Comparison, and then click Book to Book YTD Depreciation 
Comparison in the Reports list. 

 
Step 6: Optional: Guarantee the Fixed Assets Calendar is built correctly. 

1. Use the appropriate method: 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Utilities, point Fixed Assets, and then click Build Calendar. 
• In Microsoft Dynamics GP 9.0 or in Microsoft Business Solutions – Great Plains 8.0, 

point to Tools menu, point to Fixed Assets, and then click Build Calendar. 
• In Microsoft Great Plains 7.5 and for Microsoft Great Plains 7.0, point to Fixed 

Assets on the Utilities menu, and then click Build Calendar. 
2. Click Inquire, and then click Verify. When you are prompted to verify the periods, click 

OK. 
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3. In the Report Destination window, click Screen, and then click OK. 
 
Note: The Message column of the report must say OK. If the Message column says Missing for any 
line, see question 1 in the "Frequently asked questions (FAQ)" section. 
 
Step 7: Verify the quarters are set up correctly for all fiscal years.  

1. Use the appropriate method: 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Setup, point Fixed Assets, and then click Quarter. 
• In Microsoft Dynamics GP 9.0 or in Microsoft Business Solutions – Great Plains 8.0, 

point to Tools menu, point to Fixed Assets, and then click Quarter. 
2. Make sure that the following boxes are not empty: 

• Start Date 
• Mid Date 
• End Date 

Note: These boxes must exist for each quarter. If any box is empty, type the appropriate 
date in that box. 

 
Step 8: Create a backup. 
 
This backup should be stored off-site together with the rest of your year-end documentation. This 
backup gives you a permanent record of the company's financial position at the end of the year. 
Additionally, this backup can be restored later if it is required. Making a backup guarantees that you 
will be able to quickly recover should a power fluctuation or other problem occur during the year-
end closing procedures. 
 
To create a backup in Microsoft Dynamics GP, follow these steps: 

1. Use the appropriate method: 
o In Microsoft Dynamics GP 10.0, point to Maintenance on the Microsoft Dynamics GP 

menu, and then click Backup. 
o In Microsoft Dynamics GP 9.0 or in Microsoft Business Solutions – Great Plains 8.0, 

click Backup on the file menu. 
2. In the Company Name list, click your company name. 
3. Change the path of the backup file if it is required, and then click OK. 

 
Step 9: Perform the fixed assets year-end closing routine. 

1. Use the appropriate method: 
• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point Fixed Assets, and then click Year End. 
• In Microsoft Dynamics GP 9.0 or in Microsoft Business Solutions – Great Plains 8.0, 

point to Tools menu, point to Fixed Assets, and then click Year End. 
 

2. Verify the fiscal year that is displayed for each book is the current fiscal year. (The current 
fiscal year is the year that you are closing).  

 
Note: If the fiscal year that is displayed for a book is not the current fiscal year, see question 2 in 
the "Frequently asked questions (FAQ)" section. 

 
3. Click a book that you want to close, and then click Insert. Repeat this step until all the 

books that you want to close have been inserted. 
 

Note: Microsoft Dynamics GP and Microsoft Business Solutions - Great Plains perform the following 
procedures during the year-end closing routine:  

 
• In the Asset General Information window, the Quantity field is copied to the Begin Quantity 

field of the Expand Quantity window. 
• In the Expand Last Maintenance window, the YTD Maintenance amount is cleared. 
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• In the Asset Book window, the YTD Depreciation Amount is cleared. 
• The following procedures are performed: 

o The Cost Basis field is copied to the Begin Year Cost field. 
o The LTD Depreciation field is copied to the Begin Reserve field. 
o The Salvage Value field is copied to the Begin Salvage field. 

• In the Book Setup window, the Current Fiscal Year field is increased by one. 
 

Note: A report is not generated during the fixed assets year-end closing routine.  
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Frequently asked questions (FAQ) 
 
Q1: When I verified my Fixed Assets Calendar, my "Message" column had several dates that had a 
status of "Missing." How can I fix this problem? 
 
A1: If the fiscal year is not a calendar year and does not have 365 days or, for a leap year, 366 
days, you must create "dummy" calendar years in your Fixed Assets Calendar so that the calendar 
is built without any missing days. For an example of years in a fiscal period setup calendar, see the 
following table: 

Fiscal year Start date End date 

2003 January 1, 2003 December 31, 2003 

2004 January 1, 2004 December 26, 2004 

2005 December 27, 2004 December 29, 2005 

2006 

2007 

December 30, 2005 

December 30, 2006 

December 29, 2006 

December 29, 2007 

 
In this scenario, the 2007 fiscal year has only 363 days. Therefore, a dummy year 2009 that has 
365 days must be set up in the Fiscal Periods Setup window. The Start Date box for this dummy 
year would read December 28, 2007. The End Date box for this dummy year would read December 
27, 2009. As soon as this year is created, the Fixed Assets Calendar must be rebuilt and replaced. 
For more information about how to rebuild the Fixed Assets Calendar, search for the following article 
number to view the article in the Microsoft Knowledge Base:  
874133 How to rebuild the Fixed Assets Calendar in Microsoft Dynamics GP  
 
Q2: The fiscal year that is displayed for my book in the Asset Year End window is not 2009. I closed 
2007 last year, and I have not yet closed 2009. What should I do? 
 
A2: See the answer for question 5. 
 
Q3: I have closed the General Ledger module, and I now realize that I have not yet closed the Fixed 
Asset Management module. Can I perform the fixed assets year-end closing routine at this point? 
 
A3: We recommend that you close the General Ledger module last, after all the subsidiary modules 
have been closed. However, the Fixed Asset Management module can be closed after the General 
Ledger module is closed. The GL Posting (GL Interface) process can be performed, and then the 
transaction or transactions can be posted to the closed year or to the historical year in the general 
ledger. For more information about the GL Posting (GL Interface) process, see step 4 in the "Year-
end checklist" section. 
 
To post transactions to the historical year in the general ledger, make sure that the following 
options are selected in the General Ledger Setup window: 

• Allow Posting to History 
• Maintain History Accounts 
• Maintain History Transactions 
 

Notes: 
 

• To access the General Ledger Setup window in Microsoft Dynamics GP 10.0, point to Tools 
on the Microsoft Dynamics GP menu, point to Setup, point to Financial, and then click 
General Ledger. 
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• To access the General Ledger Setup window in Microsoft Dynamics GP 9.0 or in Microsoft 

Business Solutions – Great Plains 8.0, point to Setup on the Tools menu, point to Financial, 
and then click General Ledger. 

 
The posted transaction will update the historical year and roll forward as a beginning balance to the 
open year. If any expense or revenue accounts were included in the transaction, they will 
automatically close out to the Retained Earnings account or accounts. 
 
Q4: I ran the year-end routine in the Fixed Asset Management module, and then I ran depreciation 
in the new year. I see that the depreciation is highly overstated and that some of the assets have a 
negative number in the "Net Book Value" field. Why is the system calculating so much depreciation? 
 
A4: This problem occurs if the following conditions are true: 

• The year was closed. 
• The assets were not depreciated through the last day of the fiscal year. 
 

Consider the following example: 
• The fiscal year is a calendar year (January 1 through December 31). 
• The assets were depreciated through December 28 when the year was closed. 

 
In this example, depreciation will be incorrect the next time that depreciation is run. The system 
does not recalculate the yearly rate when the year-end closing routine is performed. Therefore, 
fixed assets take a full year of depreciation in the last few days that remain in the previous year 
(December 29 through December 31). The rate of depreciation is the yearly rate currently on each 
asset. Additionally, if there are assets near the end of their original life, the Net Book Value field 
may become negative.  
 
There are two workarounds for this problem: 

• Recommended workaround 
o Restore the data from a backup, run depreciation through the last day of the 

year, and then perform the year-end closing procedures. 
• Alternative workaround 

o Reset life on all the assets. 
 
Note: If amounts on the assets have ever been entered for the YTD Depreciation field or for the 
LTD Depreciation field, resetting life on the assets will change these amounts, and the result may be 
different. If you change the YTD Depreciation field or the LTD Depreciation field by resetting life on 
the asset, you will cause inconsistencies between the Fixed Asset Management module and the 
General Ledger module. These inconsistencies must be explained. 
 
Q5: Instead of completing the year-end routine for the Fixed Asset Management module, I manually 
changed the "Current Fiscal Year" field in the "Book Setup" window to the next year. Do I have to 
go back and run the year-end closing routine, or can I continue to process  
activity in the Fixed Asset Management module for the new year? 
 
A5: If no activity, such as additions, changes, transfers, retirements, or depreciation, has been run 
for the new year, the Current Fiscal Year field in the Book Setup window can be changed back to the 
previous year, and then the year-end closing routine can be processed. 
 
If any activity, such as additions, changes, transfers, retirements, or depreciation, has been run for 
the new year, restore the data from a backup and continue with the year-end closing routine. 
 
In either situation, the year-end closing routine must be run. If the year-end closing routine is not 
completed, the amount in the YTD Depreciation field will be overstated on any report that includes 
assets that were retired or fully depreciated in the previous year.  
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If the year-end closing routine is not performed, the amounts in the YTD Depreciation field will not 
be cleared. The amounts in the YTD Depreciation field will not be zeroed out. Therefore, these 
amounts will be incorrectly included on the reports for the new year.
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General Ledger 
Year End Closing Procedures 
 
Step 1 Complete the posting procedures and the closing procedures for other 

modules. 
Note: This step is only required if the General Ledger module is integrated with 
other modules. 

Step 2  Post the final adjusting entries in the General Ledger module. 
Step 3  Print an account list to verify the posting type of each account. 
Step 4  Close the last period of the fiscal year. 

Note: This step is optional. 
Step 5 Optional: Perform file maintenance on the Financial series group of 

modules. 
Step 6  Verify the settings in the General Ledger Setup window. 
Step 7  Make a backup. 
Step 8  Print a final Detailed Trial Balance report. 
Step 9  Print year-end financial statements. 
Step 10 Set up a new fiscal year. 
Step 11 Close the fiscal year. 
Step 12 Close all fiscal periods for all series. 

Note: This step is optional. 
Step 13 Adjust budget figures for the new year, and then print financial 

statements. 
Step 14 Make a backup. 
 
 
Detailed Procedures 
 
Step 1: Complete the posting procedures and the closing procedures for other modules. 
 
Only follow this step if the General Ledger module is integrated with other modules. If the General 
Ledger module is not integrated with other modules, skip this step.  

• Post final transactions in all the modules except the General Ledger module. 
• Complete the month-end procedure and the quarter-end procedure for all the modules 

except the General Ledger module.  
• Complete the year-end closing procedures for each module in the following order: 

o Inventory 
o Receivables Management 
o Payables Management 
o Fixed Asset Management 
o Analytical Accounting 

 For Microsoft Dynamics GP 10.0 Service Pack 2 and greater, functionality 
was added to consolidate balances for dimensions in Analytical Accounting. 
Please review KB 960356 to make sure you have properly marked the 
dimensions that you want to be consolidated during the year-end process. 
Please note that there is no separate year-end process that needs to be 
run in the Analytical Accounting module. When the year-end close process 
is run for General Ledger, it will automatically consolidate the balances and 
move the transactions in Analytical Accounting for dimensions that were 
properly marked. 

 For more information, click the following article number to view the article 
in the Microsoft Knowledge Base: 
960356:  The year-end close procedures for Analytical Accounting in 
Microsoft Dynamics GP 10.0 Service Pack 2 and in later versions 

 
Note: Year-end procedures for the Payroll module are independent of the procedures in other 
modules. These procedures are always performed at end of the calendar year. 
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Step 2: Post the final adjusting entries in the General Ledger module. 
 
Adjusting entries include all entries that correct errors that were made when transactions were  
recorded. Adjusting entries also include journal entries that are used to assign revenues or  
expenses to the period in which the revenues were earned or in which the expenses were incurred. 
 
If you must make any adjusting entries to allocate revenue, expenses, or depreciation to the year 
that you are closing, use the Transaction Entry window or the Quick Journal Entry window to make 
adjusting entries in the General Ledger module. 
 
If you have to track initial adjusting entries or post-audit entries separate from other fiscal periods, 
auditing periods can be set up in General Ledger. The Second Closing Period feature in the General 
Ledger module lets you have a second closing period that has the same start date as the last day of 
the first closing period. This feature lets you add initial adjusting entries in the first closing period, 
and also lets you add post-audit entries in the second closing period. This enables separate tracking 
of the adjusting entries that are made after the year is closed. For more information about second 
closing periods, click the following article number to view the article in the Microsoft Knowledge 
Base: 871679 Information about a second closing period in General Ledger in Microsoft Dynamics 
GP 
 
Note: If you are using closing periods and you reconcile, your transactions all move to the first 
period with the start date. 
 
Step 3: Print an account list to verify the posting type of each account. 
 
The posting type determines whether an account is closed to the retained earnings account or 
whether an account brings a balance forward to the next fiscal year. If the account balance will be 
brought forward at the end of the year, the posting type must be set to Balance Sheet. If the 
account balance will be closed to a retained earnings account at the end of the year, the  
posting type must be set to Profit and Loss. Use the Account Maintenance window if you must 
change the posting type for an account.  
 
Follow these steps to print an account list: 

• Click Reports, point to Financial, and then click Accounts. 
• Select All Accounts in the Reports list, and then click New. 
• Type all accounts in the Option box. 
• If you are using Microsoft Great Plains 8.0 or a later version of the program, click to select 

the Inactive Accounts check box. 
 
Note: In Microsoft Great Plains 8.0 and in Microsoft Dynamics GP 9.0, you can make accounts that 
have a balance inactive. These accounts are still processed during the year-end closing routine 
according to the posting type of the account. 

 
• Click Destination to specify a report destination, and then click OK. 
• Click Print. 

 
Step 4: Close the last period of the fiscal year. 
 
This step is optional. 
 
You can use the Fiscal Periods Setup window to close all fiscal periods that are still open for  
the year. This prevents transactions from being posted to the wrong period or year. 
 
Notes 

• Make sure that you post all the transactions for the period and the year for all modules 
before you close the fiscal periods. Later, if you have to post transactions to a fiscal period 
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that you already closed, you must return to the Fiscal Periods Setup window to reopen the 
period. 

• If you use Microsoft FRx, keep one period in the most recent historical year open to prevent 
the following error message: FRX Print Engine Failed to Load the Company Calendar. For 
more information, refer to the following article number to view the article in the Microsoft 
Knowledge Base: 874932 Failed to Load Company Calendar checklist for FRx 

• If you have Unit Accounts that you want to have Beginning Balances of zero for the new 
year, please contact LBMC Technologies, LLC – we can run a SQL script to perform this for 
you. 

 
Step 5: Optional: Perform file maintenance on the Financial series group of modules. 
 
Run the check links procedure on the Financial series group of modules. 
 
Step 6: Verify the settings in the General Ledger Setup window. 
 
If you want to keep historical records, you must click to select the Accounts check box and the  
Transactions check box in the Maintain History area of the General Ledger Setup window. The  
account history lets you print financial statements and calculated budgets from historical  
information. The transaction history lets you print detailed historical trial balances. The  
transaction history also lets you view the transaction details. Both the account history and  
the transaction history are updated during the year-end closing routine if these check boxes are 
selected. 
 
Step 7: Make a backup. 
 
Make a backup of all company data, and then put the backup in safe permanent storage. The 
backup gives you a permanent record of the company's financial position at the end of the year. The 
backup can then be restored later if it is required. 
 
Step 8: Print a final Detailed Trial Balance report. 
 
Use the Trial Balance Report window to print a year-end Detailed Trial Balance report.  
 
Note: We recommend that you post all transactions for the period and for the year for all modules 
before you print the Detailed Trial Balance report. If you post additional transactions later, we 
recommend that you print a new Detailed Trial Balance report.  
 
Step 9: Print year-end financial statements.  
 
Print any year-end financial statements that are required. The most common financial statements 
include the following:  

• Balance Sheet 
• Profit and Loss Statement  
• Statement of Cash Flows 
• Statement of Retained Earnings 

 
Step 10: Set up a new fiscal year. 
 
Before you can perform the year-end closing routine, you must set up a new fiscal year byusing the 
Fiscal Periods Setup window. 
 
 
Step 11: Close the fiscal year.  
 
To close the fiscal year, follow these steps: 
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• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, pint to 
Routines, point to Financial, and then click Year-End Closing. 

• In Microsoft Dynamics GP 9.0 or in Microsoft Business Solutions – Great Plains 8.0, point to 
Routines on the tools menu, point to Financial, and then click Year-End Closing. 

• Specify an account in the Retained Earnings Account box. 
 
The account that you specify in the Retained Earnings Account box is the account to which the 
year's profit and loss accounts are closed. The default account is the account that you specified in 
the General Ledger Setup window.  
 
All current-year earnings or current-year losses are transferred to the account that you specify in 
the Retained Earnings Account box. If you want to distribute the retained earnings for the year to 
more than one account, you can specify an allocation account to distribute the retained earnings 
amount to the appropriate accounts. For example, you could set up an allocation account to divide 
the earnings between several departments in the business. 
 
Or, you could transfer the year's profit or loss to accounts that contain a specific account  
segment. This is referred to as closing to a divisional retained earnings account. For more  
information, click the following article number to view the article in the Microsoft Knowledge Base: 
850615 How to use divisional retained earnings accounts in General Ledger  
 
See the "Frequently asked questions" section for more information about how to close to  
divisional retained earnings accounts. Specify the number that you want to use as the first journal 
entry number for the next fiscal year in the Starting Journal Entry box. 
 
You can accept the default number. The default number is one more than the highest journal entry 
number that is posted for the current year. Or, you can specify a new number. The journal entry 
number that you specify is used as the journal entry number for the Year-End Closing Report. 
 

• Click Close Year to start the routine. 
 
Important: Click Close Year one time. If you click more than one time, you will close more than 
one year during the process. Also, if the progress window appears to stop at 50 percent, do not 
restart the routine. As long as the hard disk is processing, let the process continue. If you are 
maintaining the account history, the year-end closing routine transfers all current-year information 
for each account in the chart of accounts to the account history. 
If you are maintaining the transaction history, the year-end closing routine also transfers all 
current-year information for each account in the chart of accounts to the transaction history. The 
process then prepares the accounting system for a new fiscal year. Besides transferring current-
year figures to the transaction history and to the account history, the year-end closing routine does 
the following:  

• The year-end closing routine reconciles and summarizes the general ledger balances that 
accumulated throughout the year. 

• The year-end closing routine removes accounts that are marked as inactive if the accounts 
match the criteria for deleting a posting account. Inactive accounts that have been set up 
as budget accounts can also be deleted if they have no activity for the year. These accounts 
can be deleted even if budget amounts from past years are associated with these accounts. 

• The year-end closing routine moves all profit and loss account balances to the retained 
earnings account. 

• The year-end closing routine summarizes balance sheet accounts and brings the balances 
forward as the beginning balances of the account in the new fiscal year. 

• The year-end closing routine prints the Year-End Closing Report.  
• When the year-end closing routine is complete, the Year-End Closing Report is printed. This 

report lists the accounts that were closed and the transactions that were created to close 
those accounts. The Year-End Closing Report is part of the audit trail. Save this report for 
your company's permanent records. The Year-End Closing Report cannot be reprinted. 
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Note: If you use Microsoft SQL Server and if database maintenance is not automated, we 
recommend that you perform database maintenance after you close the year. For more information 
about recommended database maintenance procedures, refer to the following article number to 
view the article in the Microsoft Knowledge Base: 866439 Recommended maintenance with SQL 
Server for Microsoft Dynamics GP databases  
 
Step 12: Close all fiscal periods for all series. 
 
This step is optional. 
 
After you complete closing procedures for all the modules, use the Fiscal Periods Setup window to 
mark all periods for all series as closed. We recommend that you do this to prevent transactions 
from being posted from any module to any period that you closed. After a period is marked as 
closed, transactions cannot be posted to the period unless you reopen the period. Later, if you must 
post a transaction to a closed period, return to the Fiscal Periods Setup window to reopen the 
period. 
 
Step 13: Adjust budget figures for the new year, and then print financial statements. 
 
Adjust budget figures by using one of the following windows: 

• Excel-Based Budgeting 
• Budget Maintenance 
• Single-Account Budget Maintenance 
• Print the Profit and Loss Statement to verify that profit and loss accounts were closed to the 

retained earnings account. 
• Print the Balance Sheet to verify that balance sheet accounts indicate that the balances 

were brought forward. 
 
If you are using Advanced Financial Analysis to print your financial statements, you must update the 
report layout to reflect the current fiscal year. To do this, follow these steps:  

• Click Reports, click Financial, and then click Advanced Financial. 
• Select the financial statement from the Reports list, click Open, and then click Layout. 
• Double-click the first column heading. 
• If the column type is set to Period Range, Year-to-Date, or Variable Year-to-Date, select the 

current fiscal year in the Year list, and then click OK. 
• Repeat step a through step d for each column of each report. 

 
Step 14: Make a backup. 
 
Make a backup of all company data, and then put the backup in safe permanent storage. The 
backup gives you a permanent record of the company's financial position at the start of the new 
year. This backup can be restored later if it is required. 
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Frequently asked questions 
 
Q1.Do I have to close the fiscal year before the first day of my next fiscal year? 
 
A1.The year-end closing routine does not have to be completed before you start your next fiscal 
year. However, we recommend that you close the year as soon as possible. For more information 
about how to print a Balance Sheet when you have two open years, refer to the following article 
number to view the article in the Microsoft Knowledge Base: 866371 Printing a Balance Sheet for 
2010 when 2009 is an open year using FRx  
 
Q2.Can I make adjusting entries after I close the year? 
 
A2.You can post to the most recent historical year if the Posting to History check box is selected in 
the General Ledger Setup window. If you post an entry to a closed year, a second entry is 
automatically made that updates the beginning balances for the current fiscal year. 
 
The following tables show an adjusting entry and  
the way the entry appears in the posting journal. 
 

Adjusting entry  

12/25/2009 Administration Expenses $500  

 Cash  $500 

Posting journal  

12/25/2009 Administration Expenses $500  

 Cash  $500 

12/31/2009 Retained Earnings $500  

 Cash  $500 

 
Q3.After I performed the year-end closing routine, beginning balances were brought forward for 
some of my sales and expense accounts. Some of my asset accounts also closed to the retained 
earnings account. Why did this problem occur, and what can I do to correct it? 
 
A3.The posting type that is specified in the Account Maintenance window for the account determines 
whether a balance is brought forward for the account or whether the account is closed to the 
retained earnings account. Accounts that use the Balance Sheet posting type carry a balance 
forward. Accounts that use a Profit and Loss posting type close to the retained earnings account. To 
resolve this problem, restore from a backup, correct the posting type, and then run the year-end 
closing routine again. 
 
For more information about how to correct accounts that have an incorrect posting type without 
restoring from backup, refer to the following article number to view the article in the Microsoft 
Knowledge Base: 864913 How to correct accounts that were set up to use the wrong posting type 
after you close the year in GL in Microsoft Dynamics GP 
 
Q4.I tried to run the year-end closing routine by using a divisional retained earnings account, but I 
received the following error message:  
 
Retained Earnings account not found. 
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What can I do to resolve the problem that provokes this error message? 
 
A4.Before the routine can continue, the year-end closing routine must validate that all the  
divisional retained earnings accounts that are required exist. For example, the Fabrikam, Inc.  
demonstration company uses an account format of nnn-nnnn-nn. The first segment represents the 
department. A retained earnings account must exist for each department that has a profit and loss 
account. For example, if sales account 400-4100-00 exists, but no 400-nnnn-nn retained earnings 
account exists, you receive this error message. For more information about how to close to 
divisional retained earnings accounts, refer to the following article numbers to view the articles in 
the Microsoft Knowledge Base: 850615 How to use divisional retained earnings accounts in General 
Ledger & 850741 Error message when you try to perform the year-end closing process in GL in 
Microsoft Dynamics GP: "Retained earnings account not found" 
An Automated Solution script may be available to perform this task. For more information about 
error messages that are related to retained earnings accounts that cannot be found, visit the 
following Microsoft Business Solutions Web site: 
https://mbs.microsoft.com/customersource/support/AutomatedSolutions.htm 
 
Q5.What happens to unit accounts during the year-end closing routine? 
 
A5.Unit accounts are treated as balance sheet accounts. Unit accounts have a balance that is  
brought forward when the year is closed. For more information about how to clear the beginning 
balances for unit accounts, refer to the following article number to view the article in the Microsoft 
Knowledge Base: 857582 Query to clear beginning balances for unit accounts 
 
Q6.I am getting ready to close my year in the General Ledger module. Must everyone quit  
Microsoft Dynamics GP or Microsoft Great Plains before I perform the year-end routine? 
 
A6.We recommend that client computer users stop work in Microsoft Dynamics GP or in Microsoft 
Business Solutions - Great Plains while the year-end closing routine is processing. If users continue 
to work in the program, transactions may have to be entered again if problems occur during the 
year-end closing routine. 
 
Q7.I want to allocate my net profit to the retained earnings account or to the capital accounts each 
month. Also, net profit is supposed to be allocated to three retained earnings accounts or capital 
accounts. Can I do this? 
 
A7.No, you cannot do this. However, you can specify a non-financial account in the Account 
Maintenance window. Use a number that is not in your current account numbering scheme. This 
account acts as a suspense account for the net income or the net loss. Every month, you can post 
an adjusting entry to the three capital accounts that you want to adjust. For the offset account, use 
the suspense account. When the year-end closing routine is finished, use the suspense account as 
the retained earnings account. This offsets all the manual adjustments that you made to the 
suspense account during the year. Make sure that the suspense account does not appear on 
reports. 
 
If you are using Advanced Financial Analysis for financial statements, when you format the Balance 
Sheet, put the NP line as the last line on the Advanced Financial Analysis statement. Then, put a 
page break before the NP line. The Balance Sheet must have an NP line, but this line makes the net 
income or the net loss appear two times. Therefore, format the NP line so that it is off the financial 
statement. You can also use a report type of Other. 
 
 
Q8.Why is the status of some of my financial reports set to Invalid? 
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A8.If a report is configured to use the accelerator file, any changes that are made to accounts in 
any one of the following windows causes the status of the financial report printing options to change 
to Invalid: 

• Account Maintenance 
• Unit Account Maintenance 
• Mass Modify Chart of Accounts 
• Year-End Closing 

 
Before you print financial statements, you must update the accelerator file. To do this, follow  
these steps: 

• Click Reports, click Financial, and then click Update Financial Accelerator. 
• Click Update, and then click Continue. 
• Close the Update Financial Accelerator Information window. 
 

 
Q9.How are non-financial accounts closed during the year-end closing routine? 
 
A9.If the non-financial account is configured to use the Balance Sheet posting type, the account 
balance is brought forward during the year-end closing routine. If the non-financial account is 
configured to use the Profit and Loss posting type, the account balance is closed to the retained 
earnings account during the year-end closing routine. 
 
Q10.When I try to post a batch in the General Ledger module, I receive the following message:  
 
Batches cannot be posted while the Year-End Close is in progress. 
 
The year-end closing routine is not being run in the General Ledger module. What should I do? 
 
A10.To resolve this issue, have all users close all transaction entry windows. Then, delete the  
SY00800 file if you are running a Microsoft SQL Server database. To do this, run the following  
statement on the DYNAMICS database.  
 
delete SY00800 where BACHNUMB = 'GL_Close' 
 
For more information, refer to the following article number to view the article in the Microsoft  
Knowledge Base: 856550 General Ledger year end close still in process and batches cannot be 
posted  
 
Q11.I receive the following message when I try to close the year in the General Ledger module:  
 
Sorry, another user is closing the year. 
 
No one else is trying to close the year. What should I do? 
 
A11. To resolve this issue, delete the SY00800 file if you are using a Microsoft SQL Server database. 
To do this, run the following statement on the DYNAMICS database. 
 
delete SY00800 where BACHNUMB = 'GL_Close' 
 
Q12.I am performing the year-end closing routine in the General Ledger module and it appears to 
be stopped at 50 percent. My workstation seems to have stopped responding. What should I do?  
 
A12.If your year-to-date transaction open file (GL20000) is large, it may take a long time for  
the year-end closing routine to finish. If the hard disk is still processing, the year-end closing 
routine has not stopped responding. We recommend that you let the routine run. If the hard disk is 
not processing, we recommend that you restore from a backup. Then, follow the steps in this article 
again, starting at step 5. 



   

Microsoft Dynamics GP 
Year End Closing Procedures 

 

Page 34 of 38 

 
Q13.If an adjusting entry has been posted to a year that is closed, can I print a corrected Trial  
Balance Report for that year?  
 
A13. Yes, you can print a corrected Trial Balance Report for the year that is closed. To do this,  
follow these steps: 

• Click Reports, point to Financial, click Trial Balance, and then click New. 
• In the Option field, type With Adjustments. 
• In the Include area, click to select the Posting Accounts check box. 
• Click to select the History check box in the Year area, and then select the historical year 

from the Year list. 
• Click Destination to specify a report destination, and then click OK. 
• Click Print. 

 
Q14.How do Microsoft Dynamics GP and Microsoft Business Solutions - Great Plains determine the 
financial statement that is printed for the account that I am adding? 
 
A14.The category determines the type of financial statement that is printed when you use quick 
financial statements for the account that you are adding. The category is either the Balance Sheet 
category or the Profit and Loss category. You must format the reports to print the accounts that you 
want in Advanced Financial Analysis and in Microsoft FRx. The posting type is used during the year-
end closing routine to determine the accounts that close to the retained earnings account and to 
determine the account that carries a balance forward. The posting type does not affect the financial 
statements. 
 
Q15.When I tried to perform the year-end closing routine, I received an error message that stated 
that a single-use batch or a quick journal transaction had not been posted. What does this error 
message mean? 
 
A15.When you try to perform the year-end closing routine, you may receive the following error 
message: A single use batch or quick journal transaction has not been posted yet. Do you want to 
continue closing? 
You receive this error message if an unposted single-use batch or an unposted quick journal 
transaction exists in GL. This error message does not prevent you from continuing with the year-
end closing routine. If you do not want to post the single-use batch or the quick journal transaction, 
continue with the year-end closing routine. 
 
Q16.When I try to perform the year-end closing routine in GL, why do I receive the following error 
message: [Microsoft][ODBC SQL Server Driver][SQL Server]Violation of PRIMARY KEY constraint 
‘PK##0671112’. Cannot insert duplicate key in object ‘##0671112’ 
 
A16.The year-end closing transaction contains a currency that is not assigned to an account. For 
more information about how to resolve this issue, refer to the following article number to view the 
article in the Microsoft Knowledge Base: 950019 Error message when you try to perform the year-
end closing routine in GL in Microsoft Dynamics GP: “Violation of PRIMARY KEY constraint 
‘PK##0671112’”
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Payroll 
Year End Closing Procedures 
 
This document outlines the recommended year-end closing procedures for Microsoft Dynamics GP 
Payroll. The "More Information" section contains the following: 

• A detailed checklist of the steps that you must follow to complete the year-end closing 
procedures. 

• An alternative checklist to use instead of the standard checklist if you must process 2010 
pay runs before you complete the year-end closing procedures. 

 
Payroll year-end checklist 
 
Step 1.Verify the version of Microsoft Dynamics GP 
Step 2.Complete all pay runs for the current year 
Step 3.Complete all monthly and quarterly payroll period-end procedures for the current year 
Step 4.Make a backup of the original file 
Step 5.Install the Year-End Update 
Step 6.Create the Year-End file 
Step 7.Make a backup of the new file 
Step 8.Verify W-2 and 1099-R statement information 
Step 9.Print the W-2 statements and the W-3 Transmittal form 
Step 10.Print the 1099-R forms and the 1096 Transmittal form 
Step 11. (Optional:) Create a magnetic media file 
Step 12.(Optional:) Archive inactive employee Human Resources information 
Step 13.Set up fiscal periods for 2010 
Step 14. (Optional:) Close fiscal periods for the payroll series for 2009 
Step 15.Install the payroll tax update for 2010 
 
Alternative payroll year-end checklist 
 
If you must process 2010 pay runs before you complete the year-end closing procedures, follow the 
steps in this alternative checklist: 
Step 1.Verify the version of Microsoft Dynamics GP 
Step 2.Complete all pay runs for the current year 
Step 3.(Optional:) Complete all monthly and quarterly payroll period-end procedures for the current 
year 
Step 4.Make a backup of the original file 
Step 5.Install the Year-End Update 
Step 6.Create the year-end file 
Step 7.Make a backup of the new file 
Step 8.Verify W-2 and 1099-R statement information 
Step 9.(Optional:) Archive inactive employee Human Resources information 
Step 10.Set up Fiscal Periods for 2010. 
Step 11.(Optional:) Close the fiscal periods for the Payroll series for 2009. 
Step 12.Install the payroll tax update for 2010. 
Step 13.Process the 2010 pay runs. The user date must occur in 2010. 
Step 14.Print the W-2 statements and the W-3 Transmittal form 
Step 15.Print the 1099-R forms and the 1096 Transmittal form 
Step 16.(Optional:) Create a magnetic media file 
 
Payroll module year-end details 
 
Verify the version of Microsoft Dynamics GP or Microsoft Business Solutions – Great 
Plains 
 
The 2009 Payroll Year-End Update file and the 2010 Payroll Tax Update file will be available for 
Microsoft Dynamics GP 9.0 and 10.0. The 2009 Payroll Year-End Update file and the 2010 Payroll 
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Tax Update file will not be compatible with versions of Microsoft Business Solutions - Great Plains 
8.0 or with earlier versions. 

Detailed information about each step in the payroll year-end closing routine is included in the 
Payroll Web services. Before you complete the steps in this document, look for updated year-end 
information by visiting the following Microsoft Web site for customers: 

Customers  
https://mbs.microsoft.com/customersource/downloads/taxupdates/ 
 
Complete all pay runs for the current year 
 
(Optional:) Complete all monthly and quarterly payroll period-end procedures for the 
current year 
For more information about period-end procedures for payroll, view Chapter 21, "Payroll Company 
Routines," in the Microsoft Dynamics GP user's manual. 
 
Make a backup of the original file  
Create a backup, and then put this backup into safe, permanent storage. By creating a backup, you 
make sure that you have a permanent record of the company's financial position at the end of the 
year. You can restore the backup to quickly recover data if a power fluctuation or other problem 
occurs during the year-end closing procedure. 
 
Note: We recommend that you name this backup 2009 Payroll Pre Year-End Update to differentiate 
it from your other backups. 
 
Install the year-end update 
To install the payroll year-end update, you must follow these steps on each computer that has 
Microsoft Dynamics GP installed: 
 
Microsoft Dynamics GP  
Install the update from the following location: 
https://mbs.microsoft.com/customersource/support/downloads/taxupdates/ 
 
Note: Microsoft Business Solutions – Great Plains 8.0 and earlier versions will not be compatible 
with the payroll year-end update file as stipulated by Microsoft Dynamics GP Support. 
 
Create the year-end file 
To create the year-end file, follow these steps: 

• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, point to 
Routines, point to Payroll, and click Year-End Closing. In Microsoft Dynamics GP 9.0 and in 
Microsoft Business Solutions – Great Plains 8.0, point to Routines on the Tools menu, point 
to Payroll, and click Year-End Closing. 

• In the Year field, type 2009, and then click Process. 
 
Note: You can install the payroll tax update for 2010 any time after the year-end file for 2009 has 
been created. 
 
Make a backup of the new file 
Create a backup, and then put this backup into safe, permanent storage. By creating a backup, you 
make sure that you have a permanent record of the company's financial position at the end of the 
year. You can restore the backup to quickly recover data if a power fluctuation or other problem 
occurs during the year-end closing procedure. 
 
Note: We recommend that you name this backup 2009 Payroll Post Year-End File to differentiate it 
from your other backups. 
 
Verify W-2 and 1099-R statement information 
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To view the W-2 information, click Tools, point to Routines, point to Payroll, and then click Edit W-
2s. 
 
To view the 1099-R information, click Tools, point to Routines, point to Payroll, and then click Edit 
1099-Rs. 
 
Note: If you change the W-2 or the 1099-R information, we recommend that you make another 
backup. 
 
Print the W-2 statements and the W-3 Transmittal form  
To print the W-2 statements, follow these steps: 

• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, point to 
Routines, point to Payroll, and click Print W-2’s. In Microsoft Dynamics GP 9.0 and in 
Microsoft Business Solutions – Great Plains 8.0, point to Routines on the Tools menu, point 
to Payroll, and click Print W-2’s. 

• In the Print W-2 Forms window, specify the following settings: 
o Print W-2s for: Normal Year-End 
o Print: W-2 Forms 

• Click Print. 
Note: You can print employee W-2 statements as many times as you have to. 
 
To print the W-3 Transmittal Form, follow these steps: 

• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, point to 
Routines, point to Payroll, and click Print W-3’s. In Microsoft Dynamics GP 9.0 and in 
Microsoft Business Solutions – Great Plains 8.0, point to Routines on the Tools menu, point 
to Payroll, and click Print W-3’s. 

• In the Print W-2 Forms window, specify the following settings: 
o Print W-2s for: Normal Year-End 
o Print: W-3 Transmittal Form 

• Click Print. 
Note: You can print the W-3 Transmittal Form as many times as you have to. 
 
Print the 1099-R forms and the 1096 Transmittal form 
To print the 1099 forms, follow these steps: 

• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, point to 
Routines, point to Payroll, and click Print 1099-R’s. In Microsoft Dynamics GP 9.0 and in 
Microsoft Business Solutions – Great Plains 8.0, point to Routines on the Tools menu, point 
to Payroll, and click Print 1099-R’s. 

• In the Print 1099-R Forms window, click 1099-R Forms, and then click Print. 
Note: You can print employee 1099-R forms as many times as you have to. 
 
To print the 1096 Transmittal form, follow these steps: 

• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, point to 
Routines, point to Payroll, and click Print 1099-R’s. In Microsoft Dynamics GP 9.0 and in 
Microsoft Business Solutions – Great Plains 8.0, point to Routines on the Tools menu, point 
to Payroll, and click Print 1099-R’s.On the Tools menu, point to Routines, point to Payroll, 
and then click Print 1099Rs. 

• In the Print 1099-R Forms window, click 1096 Transmittal Form, and then click Print. 
Note: You can print the 1096 Transmittal form as many times as you have to.  
 
(Optional:) Create a magnetic media file 
To create a magnetic media file, follow these steps: 

• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, point to 
Routines, point to Payroll, and click W-2 Magnetic Media. In Microsoft Dynamics GP 9.0, 
point to Routines on the Tools menu, point to Payroll, and click W-2 Magnetic Media. 

• In the Magnetic Media window, click to select the check box that is next to each company 
that you want to include in your magnetic media file. 
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• In the PIN field, enter the PIN. 
• Click Submitter. The Magnetic Media Submitter Information window opens. 
• Enter the authorized submission information. 
• Close the Magnetic Media Submitter Information window. 
• Change the file destination information in the File Name field if it is required. 
• Click Create File. 

 
(Optional): Archive inactive employee Human Resources information 
To archive inactive employee Human Resources information, click Tools, point to Utilities, point to 
Human Resources, and then click Archive Employee. 
 
Set up fiscal periods for 2010 
To set up fiscal periods for 2009, follow these steps: 

• In Microsoft Dynamics GP 10.0, point to Setup on the Microsoft Dynamics GP menu, point 
to Company, and click Fiscal Periods. In Microsoft Dynamics GP 9.0 and in Microsoft 
Business Solutions – Great Plains 8.0, point to Setup on the Tools menu, point to Company, 
and click Fiscal Periods. 

• In the Year field, type 2010, and then click Calculate. 
 
Note: You may want to close all periods except period 1 to prevent users from posting to future 
periods. 
• Click OK. 

 
(Optional:) Close fiscal periods for the payroll series for 2009 
You can use the Fiscal Periods Setup window to close all fiscal periods that are still open for the 
year. By closing fiscal periods, you prevent users from accidentally posting transactions to the 
wrong period or to the wrong year.  
 
Before you close a fiscal period, verify that you have posted all transactions for the period and for 
the year for all modules. To later post a transaction to a fiscal period that you have closed, you 
must first reopen the period in the Fiscal Periods Setup window. 
 
To close a fiscal period, follow these steps: 

• In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, point to 
Setup, point to Company, and click Fiscal Periods. In Microsoft Dynamics GP 9.0 and in 
Microsoft Business Solutions – Great Plains 8.0, point to Setup on the Tools menu, point to 
Company, and click Fiscal Periods. 

• Click to select the Payroll check box for each Period that you close. 
 
Install the payroll tax update for 2010 
Note: Do not install the payroll tax update for 2010 until the year-end file has been created for 
2009. 
 
To install the payroll tax update for 2010, follow these steps: 
 

• In Microsoft Dynamics GP 10.0, point to Maintenance on the Microsoft Dynamics GP menu, 
point to U.S. Payroll Updates, and click Check for Tax Updates. In Microsoft Dynamics GP 
9.0, point to Products and Services on the Help menu, and click Check for Payroll Tax 
Updates. 

• In the Tax Update Method window, click Automatic, and then click Next. 
• In the Authorization Number field, type your authorization number, and then click Log in. 
• Click Finish. 

 
Note: You may also install this update from the following alternative location 
https://mbs.microsoft.com/customersource/support/downloads/taxupdates/ 


